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Before Getting Started
Color is an important element that helps you visualize the information contained
in raster images that you display or print with TNTmips®.  The exercises in this
booklet introduce you to the many tools provided in TNTmips for manipulating
and enhancing image color in screen displays, and for adjusting color translation
to the printed page.

Prerequisite Skills  This booklet assumes that you have completed the exercises
in Getting Started: Displaying Geospatial Data and Getting Started: Navigating.
Those exercises introduce essential skills and basic techniques that are not covered
again here.  Please consult those booklets and the TNTmips reference manual for
any review you need.

Sample Data  The exercises presented in this booklet use sample data that is
distributed with the TNT products.  If you do not have access to a TNT products
CD, you can download the data from MicroImages’ web site.  In particular, this
booklet uses sample files in the COLOR data collection.  Make a read-write copy of
these files on your hard drive; you may encounter problems if you work directly
with the read-only sample data on the CD-ROM.

More Documentation  This booklet is intended only as an introduction to Getting
Good Color.  The Display volume of the TNTmips reference manual contains
more detailed information on most of the topics covered here.  You can find
additional information about the Raster Color Conversion process in the Prepare
volume of the reference manual.

TNTmips and TNTlite®  TNTmips comes in two versions: the professional version
and the free TNTlite version. This booklet refers to both versions as “TNTmips.”
If you did not purchase the professional version (which requires a hardware key),
TNTmips operates in TNTlite mode, which limits object size and does not allow
export.

The display color enhancement tools described here are available in all TNT
products.  Color conversion is not available in TNTedit, TNTview, or TNTatlas.
Printing using the Hardcopy Layout tools is also not available in TNTatlas.  All of
the exercises can be completed in TNTlite using the sample geodata provided.

Randall B. Smith, Ph.D., 17 September 2001

It may be difficult to identify the important points in some illustrations without a
color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source for the newest Getting
Started booklets on other topics.  You can download an installation guide, sample
data, and the latest version of TNTlite.

http://www.microimages.com
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Welcome to Getting Good Color
Color is an important characteristic of many raster
images, scanned maps, and other forms of spatial
data that you may work with using TNTmips.  Good
color quality makes it easier to understand and
interpret the data, both for you and for the final users
of your project results.  Achieving good color
requires subjective judgement, and in some cases
you can manipulate color to emphasize particular
features in an image.

This booklet is intended to help you enhance the
color content of images that you display on your
computer screen or print on a hardcopy output
device.  We will discuss how color is created on the
computer screen, the ways in which color
information can be stored in Project Files, and how
colors are created when you print.

To begin, let’s review two basic color models.  Both
models use sets of three primary colors that can be
mixed in varying proportions to produce a wide
spectrum of colors.  The RGB model applies when
light of different colors is mixed, as in your computer
monitor.  When two of the three primary colors (red,
green, and blue) are mixed, the wavelengths
contributed by each add together to produce
intermediate colors.  Examples are yellow (red +
green), cyan (green + blue), and magenta (blue +
red).  An equal mixture of all three additive primaries
produces white light.

The CMY model (for cyan, magenta, and yellow)
applies to color produced by mixing or overlaying
translucent inks, dyes, or glass filters.  When one of
these materials is illuminated by white light, certain
wavelengths are absorbed (subtracted from white),
and the remaining reflected wavelengths determine
the color.  Pairs of subtractive primaries can be mixed
to produce blue, red, and green.  An equal mixture
of all three yields black.  The CMY color model is
applicable to the printing process.

RGB Model

Additive mixing:
computer display

CMY Model

Subtractive mixing:
printing

The exercises on pages 4-
19 introduce you to the
manipulation of color in
screen displays.  Topics
covered include contrast
enhancement for RGB
displays, use of color
composite rasters, working
with color palettes, color
transparency for raster and
vector objects, and RGBI
display.  Page 20 is an
overview of the Raster Color
Conversion process.  Color
adjustments in the printing
process are discussed on
pages 21-27,  including
color balancing, adjusting
gamma contrast, and
printing test strips.
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STEPS
! launch TNTmips
! select Display / Spatial

Data from the main
menu

! click the New 2D Group
icon button on the
Display Spatial Data
toolbar.

Color on Your Computer Screen

NOTE: Adjusting the global
brightness and contrast
settings on your monitor has
a major effect on the
appearance of color images
on your screen, independent
of color adjustments made
in the TNTmips Display
process.

New 2D Group

The colors on your color computer screen are
specified using the additive RGB color model.  Each
picture element (or pixel) in a desktop monitor or
laptop display is actually made up of separate light-
emitting elements for red, green, and blue light.  The
amount of light emitted can be varied individually
for each of the color elements making up a pixel.  In
the simplest case, with each color element either fully
on or off, this system could produce the eight basic
colors: red, green, blue, cyan, magenta, yellow, white
(all three color elements on), and black (all three
color elements off).  In reality, modern color displays
can produce 256 intensity levels for each color
element, which in combination can produce over 16
million colors.

The trio of intensity settings for
each screen pixel are stored in the
memory module on your system’s
graphics display card.  Providing

the full color range described above (sometimes
called “true color”) requires 24 bits of memory per
pixel (8 bits = 28 = 256 levels per color element).
Most cards offer several additional display modes
that require less display memory but provide more
restricted color ranges.  In 16-bit mode, only 32
intensity levels  (5 bits) are discriminated per color
element, providing over 32,000 colors.  In 8-bit
mode, display colors are selected from a palette of
256 colors supplied by the operating system or by
the currently running software (such as the TNTmips
Display process).

For best color rendition, choose 24-bit display mode.
You may find that your choice of color settings is
limited by your current screen size setting, depending
on the amount of memory available for your display
card.  If so, decreasing the screen size (and
resolution) may enable you to increase the display
color depth.



page 5

Getting Good Color

Three-Raster RGB Display
STEPS
! click the Add

Raster icon
button on the
Group Controls window

! choose Quick-Add RGB
from the resulting option
menu

! use the standard File /
Object Selection
procedure to select
rasters RED, GREEN, and
BLUE from the STHELENS

Project File in the COLOR

data collection

A color screen image can be created from several
types of raster objects or sets of raster objects.  You
have the greatest flexibility to adjust color when you
use the RGB raster display option.  Each of the three
selected raster objects is used to control the intensity
of one of the display color components.  In most
cases the component rasters will be 8-bit grayscale
objects, but you can also use 16-bit or floating-point
rasters as RGB display components.

If your input image is a scanned photograph or map,
assigning each of the red, green, and blue compo-
nent rasters to its corresponding display
channel produces a screen display that can
closely replicate the colors of the original.
However, you can also choose a set of bands
from a multispectral image source, such as
a 7-band Landsat Thematic Mapper image,
SPOT image, or multipolarization radar im-
age.  The resulting false-color images can
be used to analyze and interpret the char-
acteristics of different image areas.

The RGB raster set for this exercise repre-
sents a natural-color photograph acquired
in 1994 by the crew of NASA’s Space
Shuttle over Mount Saint Helens volcano
in southwestern Washington, USA.  If your
computer is in 24-bit display mode, you will
see a true 24-bit color image.  If your com-
puter is in 16-bit or 8-bit display mode, the display
process automatically produces a reduced range of
colors that provides an optimal representation of the
24-bit color range provided by the RGB raster ob-
jects.

NOTE:  To produce valid results in the RGB display process, each component
raster must be a grayscale raster object.  This means that the order of raster
values must have some numerical significance, such as recording increasing
brightness for a measured wavelength band of light.  Categorical rasters, in
which raster values are merely arbitrary labels for different classes or groups,
should not be used as RGB display components.

The dark forested slopes in
the lower part of image
contrast with the barren, ash-
covered area devastated by
the 1980 eruption of the
volcano.
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Raster Contrast Enhancement Window
STEPS
! click the Tools

icon button in the
layer icon row of
the Group Controls
window

! choose Enhance
Contrast from the
dropdown menu

! in the Raster Contrast
Enhancement window,
open the Options menu
and turn on the
Envelope option (toggle
button in)

! examine the input and
display histograms for
the Red component
(shown by default)

! click the tab for the
Green component to
view its histograms

! repeat for the Blue
component

You can adjust the display of each RGB component
raster individually using the Contrast Enhancement
process.  The raw values in each input raster can be
translated to a new set of display values to enhance
brightness and contrast for each band.  In RGB
display mode these individual adjustments can be
used to improve the overall brightness, contrast, and
color balance of the image.  A look-up table of input
and adjusted values can be saved as a Contrast Table
subobject for each input raster.  These tables are then
used automatically by the Display process to
determine the screen display values.

When you display an RGB raster set, the Raster
Contrast Enhancement window displays Input and
Display histograms for one color component at a
time.  Choose the color  component you wish to
adjust by clicking the corresponding tab in the lower
part of the window.  The tabbed panel for each
component also displays the current upper and lower

limit settings for the input and output, and
includes an option button that allows you to
choose an enhancement method.

The input histogram is shown vertically along
the left edge of the window, and the display
histogram horizontally across the top.  You
can choose to show the display histogram as
a filled bar graph, or as a curve (envelope).
The translation curve shows the graphic form
of the function used to convert input raster
values to display values.  Some enhancement
methods allow you to directly manipulate the
shape of the translation curve.  (This exercise
continues on the next page).

The Method option
button on each tabbed
panel lets you choose an
enhancement method for
that display color.

Upper limit line

Input
histogram

Translation
curve

Display
histogram

Keep the Raster Contrast
Enhancement window open and
continue to the next page.
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Adjust Linear Image Contrast
STEPS
! click the tab for the Red

component
! use the mouse cursor to

drag the upper limit line
for the Red input
histogram down until the
upper Input Limit value
is 188

! click the tab for the
Green component and
change its upper input
limit to 171

! repeat for the Blue
component, setting an
upper input limit of 151

! click the Redraw
icon button on the
Group View
window

! choose Save All from
the File menu on the
Raster Contrast
Enhancement window to
save changes for all
three contrast tables

Each of the three raster components of the Mount
Saint Helens image already has a stored Linear
contrast table that maps input raster values to display
values using a simple linear function.  These tables
were selected by default when you displayed the
image.  The image shows good color balance, but is
somewhat dark and has low contrast.

The input histograms show that most cell values in
the three rasters fall in the lower part of the 8-bit
data range, and none of them has a significant number
of cells with high values.  We can therefore improve
the image appearance by lowering the maximum
input limit for each color component.  Lowering these
limits by roughly similar amounts shifts the display
means to higher values, which brightens the image
without adversely affecting the color balance.  It also
spreads the remaining set of input values over a wider
range of display values, increasing the contrast.  Cells
with input values above the upper limit in all three
rasters display as white.  These cells correspond to
the area of snow around the summit of the
mountain, which of course should appear
white.

You can change input limits by moving
the limit lines manually, or by typing a
new value in the corresponding text box.

Keep the Raster Contrast Enhancement
window open and continue to the next
exercise.
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Adjust Exponential Image Contrast

Remove the RGB layer for
the next exercise

STEPS
! click the tab for the Red

component and select
Exponential from the
Method option menu

! use the mouse cursor to
drag the translation
curve toward the lower
right until the Power
value is 0.87

! choose Save As from
the File menu and save
a new contrast table for
Red with the default
name Exponential

! repeat the last two steps
for the Green
component, setting a
Power value of 0.90

! click the Redraw icon
button on the Group
View window

After the contrast adjustments you made in the
previous exercise, the brighter, nonvegetated areas
in the Mount Saint Helens image show good contrast.
The forested areas, however, are still somewhat dark
and lacking in detail.  We can preferentially improve
the brightness and contrast of the forested areas by
using Exponential contrast enhancement.  In this
method, display brightness is an exponential function
of the input value.  You can vary the function
graphically by manipulating the translation curve,
or enter an exponent value in the Power text field.
The default power value is 1.00, corresponding to a
simple linear enhancement.  Power values less than
1.00 increase the mean output brightness, but
preferentially increase the brightness and contrast
of the lower range of input values.  Power values
greater than 1.00 lower the mean brightness, but
preserve contrast over the upper range of input
values.

Mount Saint Helens image after exponential
contrast enhancement of Red and Green.
Forested areas are brighter and have better
contrast; nonvegetated areas are more brown.

Drag the translation
curve for the Red
component to the
lower right until
the Power
value
equals
0.87.
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Automatic Contrast Enhancement
STEPS
! select Add RGB

Rasters from the
Add Raster icon button
menu

! select rasters RED,
GREEN, and BLUE from the
SYRDARYA Project File

! in the Raster Layer
Controls window, note
the default choices for
Contrast for the Red
component, then click
[OK]

The Contrast option buttons on the Raster Layer
Controls window allow you to choose a contrast table
to use for each input raster.  The default choice is
the table last used to display the object.  You can
also choose to use one of several automatic contrast
enhancement methods, or choose None to use raw
raster values as display values.  The automatic
methods use default settings to stretch the range of
input values to the full range of display values (for
8-bit rasters).

If no contrast table has been saved for an object, as
is the case for the raster objects used in this exercise,
the Auto Normalize contrast option is the default
selection for 8-bit rasters.  This method attempts to
rescale the input values to fit a normal (symmetrical
bell-shaped) distribution of display values.  The
median of the normalized distribution is set to the
middle of the output range (128).

Space Shuttle photograph of the semiarid Syr-
Darya River region of Tajikistan, Kyrgyzstan,
and Uzbekistan, displayed with auto-normalized
contrast enhancement.  Irrigated fields of the
river valley are seen in the upper left.

! select Enhance Contrast
from the Tools icon
button menu

Keep the Raster Contrast
Enhancement window open and
continue to the next page.

Median of the
normalized output
distribution.
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STEPS
! click the tab for the Blue

color component
! click on the middle

dashed line in the
Display histogram and
drag the line to the left
until M=100

! redraw the
display in the
View window

! select Save All from the
File menu on the Raster
Contrast Enhancement
window and name each
of the three new contrast
tables

! choose Close from the
File menu

Adjust Normalized Image Contrast
The auto-normalized display of the Syr-Darya shuttle
image has a hazy appearance in some areas, and an
overall bluish tint.  Because the automatic contrast
enhancement methods stretch each color component
independently, they can over-stretch one or more of
the components and thus not produce an appropri-
ate color balance in the RGB display.  In this exer-
cise you reduce the brightness of the blue compo-
nent of the image and save a new set of contrast
tables.

You can change the position and shape of the
normalized display histogram by moving the vertical
dashed lines.  Moving the middle line (representing
the median brightness) to the left shifts the histogram
toward lower values, reducing the overall brightness

for that component.  You can also move the
flanking deviation lines to increase (stretch)
or reduce (compress) the contrast for the upper
or lower parts of the input range.

The default choice on each contrast
method option button is the method
currently used to display that color
component.

Remove the RGB layer for
the next exercise

Syr-Darya image after adjusting the auto-
normalized contrast for the blue color
component.

Drag the median
line of the display
histogram to the
left until the
Median value
equals 100.
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STEPS
! select Quick-Add

Single from the
Add Raster icon button
menu

! select raster object
COMP24 from the COLOR

Project File
! select Setup

Datatips from the
layer Tools icon
button menu

! in the Spatial DataTip
Selection window, make
sure that the Show
DataTip toggle button on
the Raster Cells panel is
turned on

! place the cursor over
any part of the displayed
image until the datatip
appears, and note the
values

! remove the
COMP24 raster
layer

! repeat the first two
steps, selecting the
COMP16 object from the
COLOR Project File

Color information can also be stored in a single
composite color raster object.  TNTmips supports
several types of composite color objects.  The first
object used in this exercise is a 24-bit color
composite, which can reproduce any color created
by an RGB display of three 8-bit raster objects.  A
24-bit composite raster stores three values for each
cell  (one for each display color), with an 8-bit data
range for each value.  A 16-bit composite raster has
a similar three-value format, but uses only a 5-bit
data range (32 brightness values) for each display
color.  You will probably see no discernible loss in
color quality between the 24-bit and 16-bit composite
versions of most images.

When you display a 24-bit or 16-bit composite color
object, no interactive contrast enhancement is
available.  You can use the Color Conversion process
(discussed subsequently) to create a fixed, composite
color object from a contrast-enhanced RGB raster
set.

Single-Raster Composite Color

NASA Space Shuttle photograph of Alexandria, on the
Mediterranean coast of Egypt.  The green vegetation of
the Nile River delta in the lower right contrasts with the
barren sands of the Western Desert in the lower left.

24-bit and 16-bit
composite color
rasters store
separate Red,
Green, and Blue
values for each
raster cell.

Remove the COMP16
layer for the next
exercise
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Composite Color with Color Palette
STEPS
! select Quick-Add

Single from the
Add Raster icon button
menu

! select raster object
COMP8 from the COLOR

Project File
! select Edit Colors

from the layer
Tools icon button menu

! after you have examined
the color palette, select
Close from the File
menu

Natural color image of South America
from data acquired by the SeaWiFS
satellite.  The most cloud-free parts of
images acquired over a 15-day period
(18 September to 3 October 1997) were
assembled to produce the final image.

The Color Palette Editor window shows the
color assigned to each possible raster
value, from 0 in the upper left to 255 in the
lower right.  (Raster values are ordered
from left to right, then from top to bottom in
the sample array).

A final option for color composite images is an 8-
bit composite color raster.  This type of raster object
can include up to 256 unique colors.  The numeric
values in the raster are arbitrary, and serve merely to
assign display colors from a color palette (or color
map) stored as a subobject of the raster.  The color
palette records a set of RGB values for each of the
raster values in the 8-bit data range (0 to 255).  A
color map subobject is created automatically when
you import an 8-bit color composite image, or when
you use the Color Conversion process to create an
8-bit composite color raster from an RGB raster set
or 24- or 16-bit composite raster.

The Color Palette Editor displays the array of as-
signed colors for the current composite raster object.

Assignment of colors to particular raster val-
ues is arbitrary, so there is no obvious order
to the color palette for a composite color
raster.  Likewise, displaying the raster with-
out the color map does not produce a
meaningful grayscale image.

Remove the COMP8
layer for the next
exercise

Raster value 0 Raster value 255
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Grayscale Raster with Color Palette
STEPS
! select Add Single

Raster from the
Add Raster icon button
menu

! select raster object
DEM16 from the COLOR

Project File
! in the Raster Layer

Display Controls window,
make sure that
ColorMap is selected on
the Color Palette option
button, then click [OK]

! select Edit Colors
from the layer
Tools icon button
menu

A color palette can also be used to create a
pseudocolor display from a grayscale raster object.
When the raster values represent a smoothly varying
surface, you can create a color palette with a
similarly smooth gradation of colors to emphasize
the characteristics of the surface.  A color map can
be used with any type of grayscale raster object, but
no more than 256 colors can be included in the color
palette.  When you use a color map with a 16-bit or
floating-point raster object, the display process
automatically partitions the range of raster values
into 256 bins for purposes of color assignment.  If
you select a contrast option other than None, the
contrast enhancement is applied before the color
assignments are made from the color palette.

Digital elevation model of Mount Saint
Helens, Washington.  The color map
portrays low elevations in green, grades
up through yellow to brown, and shows
the mountain summit in very light gray.

Upper right portion of
the DEM (a 16-bit
raster) displayed
without the color map.
Displaying the DEM
with the color map
creates a more lively
and interesting
display, and brings
out more detail.

You can edit any color in the color palette by
clicking on its tile and manipulating the sliders for Red,
Green, and Blue.  (Sliders for the HIS, HBS, CMY, and
CMYK color systems are found on their respective
tabbed panels).  The X symbol marks the selected color.

Keep the Color Palette
Editor window open and
continue to the next page.
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Color Spaces and Color Spreads

Black

White

Saturation

Hue

R

Y

MB

C

G

! click on the Spread tab
in the Color Palette
Editor, then click on the
Mode option button to
reveal the selection of
available color spread
models

You can create a color palette with smooth color
gradations by applying a color spread to all or part
of the palette.  You first assign a color for the low
and high ends of the selected value range; applying
the spread creates a gradual color variation across
the range of intervening values.

Several color spread modes are available.  Each
mode uses a particular color model to represent
ranges of colors.  These color models are most eas-
ily understood if they are represented graphically as
three-dimensional color spaces.

The RGB color model represents colors within
a cubic volume defined by orthogonal Red,
Green, and Blue axes.  Black is at the origin of
the coordinate system (R=G=B=0), and white
is at the opposite corner of the cube
(R=G=B=255).  The diagonal connecting the
black and white corners (gray dashed line)
contains the range of neutral gray levels.
Complementary colors (such as blue and yellow)
lie at opposite corners of the cube.  An R-G-B
color spread includes colors found on a straight
line connecting the two end-member colors (for
example, the edge connecting red and yellow).

HIS
Color
Space

The Hue-Intensity-Saturation (HIS) color model
represents colors within a double-cone space.  The vertical
axis is intensity, which represents variations in the
lightness and darkness of a color.  The 0 intensity level
is black; full intensity is white.  HIS values elsewhere
along the intensity axis represent different levels of
gray. On any horizontal slice through the model space,
the hue (or “color” of the color) varies around the slice,
and the saturation (the purity of the color) increases
radially outward from the central intensity axis.
Maximum saturation in this model is at the midpoint of
the intensity range.  (The closely-related HBS model uses
a single-cone color space with maximum saturation at
full brightness.)  You can apply an HIS spread in either the
clockwise (CW) or counterclockwise (CCW) directions
around the cone.  (The directions are defined in terms of a
view upward along the intensity axis; the arrow shows the
counterclockwise direction).

I
n
t
e
n
s
i
t
y

Red

B
lu

e

Green

255

255

2550

Yellow

Cyan

Magenta

White

Black

RGB
Color Space
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STEPS
! on the RGB panel, move

the Red slider Red to 40
and the Green slider to
20

! click on the color tile in
the lower right corner of
the color palette (index
255)

! move all three sliders all
the way to the right to
set index 255 to white

! on the Spread panel,
select HBS CW from the
Mode option menu

! press [Apply Spread]
! click the Redraw

icon button on the
Group View
window

Creating a Color Spread
Now let’s try creating a clockwise HBS color spread
from brown (for the 0 palette index) to white (for
255). This produces a smooth gradation from brown
to green, gray, and white.

You can use the Set buttons to designate any
selected palette index as the start or end of a
color spread (0 and 255 are the default values).
You can design complex color palettes by
specifying a number of intermediate colors,
then creating color spreads between them.

Use the Red
and Green
sliders to
change the
color for palette
index 0 to
brown.  The
color tile next to
the Index field
shows the color
for the current
index value.

Change the color for
palette index 255 to white.

Keep the Color Palette Editor
window open and continue to the
next exercise.

After you apply the
spread you can
choose Save As from
the File menu to save
the new color palette
as a subobject of the
current raster object.

Lower part of the Mount Saint Helens
DEM with the new color spread applied.
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Using Standard Color Palettes
STEPS
! select Rainbow 1 from

the Palette menu in the
Color Palette Editor
window

! click the Redraw
icon button on the
Group View
window

Mount Saint Helens DEM displayed with
the Rainbow color palette.

Standard Random color palette.

Standard Red Linear color palette.

Standard Rainbow 1 color palette.

The Display process also provides a number of
standard color palettes that can be selected from the
Palette menu for use with any raster object.  The
Rainbow palette mimics the range of colors in a
rainbow, from purple (index 0) through blue, green,
yellow, red, and pink (index 255).  The Gray, Red,
Green, and Blue Scale palettes each have index 0
set to black, then progress through increasing levels
of the respective color.  The Random color palette
has colors assigned randomly to the palette index
values.

You can edit any standard palette to create a new
color palette.  After editing, you can choose Save
As from the File menu to save the new palette as a
subobject of the current raster.  Alternatively, you

can use  the Save As option on the Palette
menu to save the new palette as a standard
palette. The new palette is added to the
Palette menu, and so becomes available for
use with any raster object.

Close the Color Palette Editor window and
close the current group for the next exercise.
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Using Transparent Raster Colors

Mount Saint Helens DEM displayed in two
layers: color-mapped with each color 25%
transparent in the upper layer, and in
shaded relief in the lower layer.  A saved
transparent color map is stored with the
DEM16 raster as subobject TransColor.

STEPS
! click the Open

icon button on
the Display
Spatial Data toolbar and
choose Open Group

! select DEMGROUP from the
COLOR Project File

! click the Tools
icon button on the
upper layer controls icon
row and select Edit
Colors from the menu

! in the Color Palette
Editor window, hold
down the Shift key while
clicking on the lower
right color tile (index
255) to select the all
palette colors

! enter 25 in the
Transparency text box

! redraw the
display in the
View window

Close the Color Palette Editor
window and close the current
group for the next exercise.

A cross symbol marks the
tiles for colors that have a
non-zero transparency value.

These icon buttons provide a quick means to
set selected colors completely opaque or
completely transparent.

Set Selected
Opaque
(0 Transparency)

Set Selected
Transparent
(100% Transparency)

Enter transparency
percentage values in the
Transparency text box.

Holding down the Shift key while clicking on a
color tile selects the entire color range from the
previously selected tile (in this case, index 0) to
the new tile (index 255).

The Color Palette Editor also allows you to set a
transparency percentage value for any or all colors
in the palette, from 0 (completely opaque) to 100
(completely transparent).  The color-mapped raster
can then be displayed over other layers to add
information without obscuring the underlying
objects.  The two-layer display of a DEM in this
exercise combines elevation-keyed colors with the

visual effect
of shaded
relief.
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Vector Polygon Fill Transparency
STEPS
! click the Open

icon button on
the Display
Spatial Data toolbar and
choose Open Group

! select HAZGROUP from the
COLOR Project File

! click  the Vector
icon button in the
COLOR / HazZones
layer icon row

! click the Polygons tab in
the Vector Layer
Controls window,  then
click [Specify...] for
Style: By Attribute

! on the Style Assignment
window that opens,
press [Edit]

Mount Saint Helens DEM displayed with
relief shading, overlaid by a vector
hazard zonation map.  The polygon fills
are solid colors with 75% transparency,
so the underlying terrain remains visible.

Close the Style Editor, Style Assignment,
and Vector Object Display Controls
windows, then close the current group for
the next exercise.

Set a Transparency percentage for solid
polygon fills in the Style Editor window
(0% = completely opaque fill, while 100%
= fully transparent = no color fill).

Solid color fill styles that you create for vector or
CAD polygons or for TIN triangles also can be dis-
played with varying degrees of transparency.  The
object with transparent fills can then be displayed
over another object (such as a raster image), and the
information conveyed by both layers is easily vis-
ible.  Once you have set a transparency value as part
of the definition of a fill style, the transparency ef-
fect is used automatically in both the standard display
process (in both 2D and 3D views) and when you
print.  For more information on vector display styles,
consult Getting Started: Creating and Using Styles.
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RGBI Raster Display
STEPS
! click the New

Group icon
button on the
Display Spatial Data
toolbar

! select Quick-Add
RGBI from the
Add Raster icon
button menu

! from the RGBI Project
File, select raster object
TM5R for Red, TM4R for
Green, TM3R for Blue,
and SPOTPAN for Intensity

RGB display of objects TM5R, TM4R, and
TM3R.  (These objects were produced by
resampling to the 10-m cell size and
extent of the SPOT panchromatic image.)

RGBI display of the same three TM
rasters with object SPOTPAN as Intensity.
The resulting display combines the high
spatial resolution of the SPOT
panchromatic image with the spectral
content of the TM bands.

The RGBI raster display mode uses four raster
objects to produce an enhanced RGB display.  The
three rasters selected as Red, Green, and Blue
components are first converted to the HIS color
space.  The designated Intensity object is then
substituted for the calculated intensity, and the rasters
are converted back to the RGB color space for
display.  All selected objects must have the same
cell size and extents.

The RGBI display mode is useful for merging visual
information obtained by different sensors.  For
example, an RGBI display might use three bands
from a multispectral optical sensor (such as Landsat
TM or SPOT XS) to determine hue and saturation,
and a grayscale radar image to set the intensity.  This
exercise shows another example, in which a high-
resolution panchromatic image is used as the
intensity component to enhance the spatial
resolution of the multispectral bands.

Close the current group
for the next exercise.
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Color Conversion Process
STEPS
! select Process / Raster /

Combine / Convert Color
from the TNTmips main
menu

! select RGB Separate
from the Input Type
option button

! click [Select Raster(s)...]
and  select rasters RED,
GREEN, and BLUE from the
STHELENS Project File

! select HIS from the
Output Type option
button

! click [Run]
! use the standard File /

Object Selection
procedure to name a
new Project File and the
output raster objects

Intensity raster created from RED, GREEN, and
BLUE color component rasters, displayed with
auto-normalized contrast enhancement.

Choose the Single option
to select a color composite
raster for conversion.

Output type
options.

Click Exit to close
the Raster Color
Conversions
window.

The Color Conversion process allows you to change
the storage mode or color space of any color image.
You can convert from or to a single color composite
raster, an RGB raster set, or Hue-Intensity-Saturation
(or related variant) raster set.  With RGB input rasters
you can select contrast tables or automatic contrast
enhancements to be applied during conversion.

When you have an RGB image which is dark but
has good color balance, conversion to the HIS color
space can provide an easy means of enhancing the
color.  You can display the output Intensity raster,
adjust its brightness and contrast, and select the
resulting contrast table for use during the
reconversion from HIS to RGB.  The resulting RGB
raster set will show improved brightness and contrast
while retaining its original hues.
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Highly magnified portion of
the Alexandria Space
Shuttle photo.  A 24-bit color
image includes very subtle
cell-to-cell color variations.

Same area dithered for printing.  At this layout scale,
each input raster cell is represented by a 5 x 5 array of
printer dots.  The dithering process uses different
patterns of the available print colors to recreate the
wide range of colors in the original image.

Now that we have covered the basics of producing
good colors when displaying images, we turn to the
realm of printing color images.  Let’s begin by
considering how printers reproduce colors.  Most
digital printers apply tiny dots of cyan, magenta, and
yellow ink to the page.  For most common printers
(such as ink-jet and solid-ink types), these dots have
a fixed size, and each ink color is either fully “on”
or fully “off” for each dot.  By overlaying the
translucent inks on a single dot, these printers can
also produce blue, green, red, and black dots.  If no
ink is applied for a dot position, it remains white.

Printers use these eight basic colors to simulate a
much wider range of image colors.  This is possible
because of the printer’s high spatial resolution.  In
other words, the ink dots are very tiny and very close
together, which has two important consequences.
First, a single image pixel is commonly represented
by an array of ink dots.  Second, we can’t distin-
guish the individual dot colors, but instead perceive
a blended color produced by groups of nearby dots.
By varying the colors and placement of printer dots
for each image cell (a process called dithering), the
printer can produce the visual effect of the original
colors in the image.

Low end printers use only
cyan, magenta, and yellow
inks.  Four-color (CMYK)
printers include a separate
black ink supply (K) to
produce pure black tones
and reduce the use of the
colored inks.  Some new
desktop printers now offer
six or seven inks, including
lighter hues of the primary
ink colors.

Printer resolution is
measured in dots per inch,
abbreviated dpi.  Typical
desktop printers have print
resolutions of 300 to 720
dpi.  High-end printers used
by graphics service bureaus
may have resolutions of
1200 or 2400 dpi.

In a Dither about Printing
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To illustrate the color adjustments available during
printing, we will work with a sample hardcopy lay-
out designed for printing to an 8.5" x 11" page in
portrait orientation.  You can print layouts up to 11"
x 17" in size with TNTlite, TNTview, or TNTedit.
The professional version of TNTmips supports print-
ing to a variety of page sizes (up to 44" rolls) and
printing over multiple pages.

You make color adjustments for printing using the
Page Setup window, which comes in two versions.
When you choose Page Setup from the Layout menu
on the Layout Controls window (or choose Support
/ Setup / Printers from the TNTmips main menu),
you can set up basic print parameters and save them
by pressing the OK button without actually initiating
printing.  When you select Print from the Layout

menu, the Page Setup window opens with a
Run button in place of OK, but the remaining
controls are identical.  Pressing the Run button
starts the printing process and closes the
window.

Page Setup Window
STEPS
! click the Open

icon button on
the Display
Spatial Data toolbar and
choose Open Layout

! select DEM_LAYOUT from
the COLOR Project File

! choose Page Setup from
the Layout menu on the
Layout Controls window

The layout used in this
exercise was created using
standard tools available in
the Hardcopy Layout
process.  For an
introduction to the use of the
layout tools, consult the
Getting Started booklet
Making Map Layouts.

You should already have a printer set up from
the Print exercise in Getting Started: Displaying
Geospatial Data.  If not, use the controls on
the Printer tabbed panel to select one.

Select Page Setup from the Layout menu.

If you are running TNTmips under Windows95 or NT, you can click the Use Windows
Printer radio button to use your Windows print driver to control printing.
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Choosing Dither Patterns
STEPS
! click the tab for the

Dithering panel, and
press [Raster Dither
Pattern...]

! from the list in the Dither
Pattern window that
opens, select Stucki

! click [OK] to close the
Dither Pattern window

! click [OK] on the Page
Setup window

! click the Print
icon button on
the Layer Controls
window to print the
layout

Dye sublimation printers
and film recorders are not
limited to the eight basic dot
colors produced by most
printers.  They are able to
continuously vary the level
of each color component
used to reproduce the
image pixels, resulting in
true continuous-color
output.  Dithering is not
required when you print to
one of these devices, so the
dither pattern controls are
inactive.

The two sliders on the Dithering panel can be used to
adjust the overall brightness (upper slider) and
contrast (lower slider) for the print output.   Moving a
slider to the right increases its respective property in
the print.  But for better and more predictable results,
you should use the Intensity and Saturation sliders on
the Color panel (described subsequently).

The controls on the Dithering tabbed panel allow
you to choose dither patterns for both raster and
nonraster components of your print layout.  The
Floyd-Steinberg, Jarvis-Judice-Ninke, Stucki, and
Ordered Dither patterns usually provide good results
for color images on most printers, and the choice
between them is a matter of personal preference.  The
sample in the lower part of the Dither Pattern window
gives you some idea of how the pattern looks for
different colors.  The Stucki (enhanced gray) pattern
provides the best results when you print a grayscale
raster image.  The default Vector pattern for nonraster
components insures continuity of thin lines in vector,
CAD, or TIN overlays, and those in map grids, scale
bars, and legends.

The print drivers supplied with many printers now
have built-in dithering capability.  If you are printing
to a Windows printer using the Windows print driver,
you have the choice of letting either TNTmips or
the Windows print driver do the dithering.  The latter
choice typically requires more processing time than
using the TNTmips dithering process.
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Using dithering, a printer can produce a range of
colors comparable to that of a computer monitor.
But dithering doesn’t ensure that a particular color
generated by the printer will look the same as the
corresponding color on the display screen.  Because
of the different ways in which the colors are created,
there is usually a significant shift in colors between
the screen display of a raster image and the printed
version, and some display colors may be outside the
printer’s available range of colors.

The Color panel of the Page Setup window provides
a number of controls that allow you to alter the
manner in which image colors are translated to the
printer.  Using these controls you can adjust the
colors produced in the print without altering the

contrast tables or color palette you
have created to provide screen
colors.

The colors produced by inkjet
printers are often darker and less
saturated than the corresponding
screen colors.  The lower part of the
Color panel includes two horizontal
sliders that use the HIS color model
to modify all of the colors in the
print image simultaneously.
Moving the upper slider to the right
increases the intensity (brightness)

of all colors.  Moving the lower slider to the right
increases the saturation of each hue at the expense
of intervening pastel shades.  The color sample bar
above these sliders changes as you move the sliders,
giving you a preview of their overall effects.  Many
natural color images benefit from modest increases
in intensity and saturation during the print process.
However, if part of the image is already very bright,
increasing the overall intensity may “wash out” the
color in this part, resulting in a local loss of detail.

Adjusting Intensity and Saturation
STEPS
! select Print from the

Layout menu
! click the Color tab on the

Page Setup window
! slide the Intensity slider

back and forth and note
the effect on the color
sample bar above it

! repeat with the
Saturation slider

! set the Intensity level to
20 and the Saturation
level to 15

! press [Run...] to print the
layout and close the
Page Setup window

The intensity and saturation
slider settings are not saved
between print jobs, or when
you press [OK] on the
nonprinting Page Setup
window.  If you are using
slider settings other than the
default 0 values, you must
reset the sliders each time
you print.

Intensity slider Saturation slider
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Color Balancing
The controls you adjusted in the previous exercise
influence all of the raster image colors in your print.
However, all screen colors may not print equally well
from a given layout.  For example, green and blue
typically print darker than other colors on inkjet print-
ers, and deep blue colors on the screen often appear
closer to purple when printed.  You can use the ver-
tical color sliders in the Color panel in conjunction
with the four icon buttons in the lower left part of
the panel to adjust individual output colors.

With the Brightness icon button turned on, moving
a slider increases or decreases the intensity of its
color.  With the Saturation button turned on, move a
slider up to increase the saturation (purity) of the
color, or move the slider down to move the color
toward gray.  The color bar beneath the sliders
previews the resulting effects.  Slider positions are
not automatically saved when you run the print
process or click [OK] on the nonprinting Page Setup
window.  However, you can save these settings at
any time in a color balance object by pressing the
Save button, and recall saved settings using the Load
button.

STEPS
! select Print from the

Layout menu
! click the Color tab on the

Page Setup window
! with the Brightness icon

button selected (the
default) move the Green
slider upward to a value
of 10.6 and the Magenta
slider downward to a
value of -6.1

! press the Saturation
icon button, and move
the Green slider upward
to a value of 10.6

! press [Save], use the
File / Object Selection
window to navigate to
the COLOR Project File,
and name a new color
balance object

! press [Run] to print the
layout and close the
Page Setup window

My printer produces greens
in the Mount Saint Helens

DEM that are too dark and too olive
in tone.  The settings in this exercise
compensate by increasing the
intensity of green, decreasing the
intensity of its complement, magenta,
and increasing the green saturation.

Brightness

Hue ShiftHue

Saturation

The color sliders can also
be used in conjunction with
the Hue and Hue shift icon
buttons to modify selected
hues, but this is a tricky
procedure which may pro-
duce unexpected results.
You should be able to
achieve a good color bal-
ance using only the
Brightness and Saturation
settings.
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Adjusting Gamma Contrast
The Gamma Contrast window provides an alterna-
tive means of selectively adjusting how screen colors
are translated to print colors.  The relationship be-
tween the brightness variation of a color in a print
and the brightness variation of that color in a screen
display is typically not a linear one.  Instead, it is
approximately a power function.  That is, the print
brightness equals the screen brightness raised to
some exponential power.  In computer graphics, the
Greek letter “gamma” is the symbol used for the nu-
merical exponent in the power function.

The Gamma Contrast window has a Power text box
for each color component in which you can enter a
value for the gamma exponent (the default is 1.00,
which defines a linear brightness translation).  The
Mode option button allows you to choose between
RGB (display color) or CMY (ink color) modes for
specifying gamma values.  Although color printing
uses CMY, it is easier to visualize the results using
RGB mode.  Entering a gamma value greater than
1.0 for red, green, or blue brightens the low to middle
intensity range of the color in the print; entering a
value less than one has the opposite effect.

STEPS
! select Print from the

Layout menu
! click the Color tab on the

Page Setup window
! click [Gamma...]
! in the Gamma Contrast

window, use the mouse
to highlight the Power
text box for Green, and
type in the value 1.4

! change the Power value
for Blue to 1.2

! click [OK] to accept the
values and close the
Gamma Contrast
window

! press [Run] to print the
layout and close the
Page Setup window

The Gamma Contrast
window opens with default
values for gamma of 1.00
for each color component.

RGB is the default color mode.

The gamma values used in this exercise
are designed to brighten the green colors in
the print without brightening red.  Green
areas should appear brighter in the print,
and brown areas should contain less red.

You can also change the allowed
minimum and maximum input and
output values to adjust the brightness
and contrast of the print.
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Printing Test Strips
STEPS
! select Print from the

Layout menu
! click the Color tab on the

Page Setup window
! set the horizontal

Brightness slider to 20
and the Saturation slider
to 10

! click [Test...]
! in the Test Strip Setup

window, click [Add]
! with the Brightness icon

button turned on, set the
color sliders to the
following values from left
to right:

 0.0, -4.5, -4.5, 0.0, 6.1, 3.0

! click Add again
! repeat the last two steps

with the following slider
settings:

 0.0, -6.1, -6.1, 0.0, 10.6, 6.1

! click [OK] on the Test
Strip Setup window to
print the test strips

The settings on the Color panel affect the printing
process and not the screen display, so you must print
the layout to assess the results.  It may take some
trial and error to discover the best settings for your
printer, and printing the entire layout for each change
in settings would be time-consuming.  To avoid this
problem, you can print a set of test strips of a raster
layer that use a sample area to show the results of a
number of different color balance or gamma con-
trast settings.

If there is more than one
raster layer in your layout,
use the Layer option button
to choose which layer to
test.

Each test strip is preceded by a listing of all settings:

Color Balance Gamma Contrast:
RGB CMY

You can adjust settings for any or all of the color
balance parameters before adding a listing in the
Test Strip Setup window.  The listing shows the
settings for whichever parameter is currently
selected by a color balance icon button.
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Advanced Software for Geospatial Analysis
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M icro Im a g es, In c .
11th Floor - Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010  USA

Voice: (402) 477-9554 email: info@microimages.com
FAX: (402) 477-9559 internet: www.microimages.com

MicroImages, Inc. publishes a complete line of professional software for advanced geospatial
data visualization, analysis, and publishing.  Contact us or visit our web site for detailed prod-
uct information.

TNTmips TNTmips is a professional system for fully integrated GIS, image analysis, CAD,
TIN, desktop cartography, and geospatial database management.

TNTedit TNTedit provides interactive tools to create, georeference, and edit vector,
image, CAD, TIN, and relational database project materials in a wide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project materials on CD-
ROM at low cost.  TNTatlas CDs can be used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or on your intranet.
Navigate through geodata atlases with your web browser and the TNTclient Java applet.

TNTlite TNTlite is a free version of TNTmips for students and professionals with small
projects.  You can download TNTlite from MicroImages’ web site, or you can order
TNTlite on CD-ROM.
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